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Educating for the 3rd millennium

A conference at Cheltenham and Gloucester College of
Higher Education 13-16 July 2000

This promises to be a very exciting conference;
among the keynote speakers will be Prof. Tim
Brighouse and Gabriel Goldstein. There will be
ample opportunity to meet and discuss current
issues with other primary colleagues, as well as to
attend workshops and presentations addressing
such aspects of primary practice as management,
inclusion, learning environments and classroom
case studies. There will also be a major exhibition
giving everyone a chance to find out what’s
available.

Of particular interest to MAPE members will be
a presentation by Martin Ford on Sir Henry Unton.

It was Martin who first suggested to us that Sir
Henry Unton would be an interesting subject for a
History Focus, and he kindly made his extensive
resources available to us when the material for the
CD was in preparation.

What conference would be complete without a
MAPE Barn Dance? This will be held on the
Friday evening, and on Saturday the after dinner
speaker is Gervaise Phinn.

There is a day delegate rate of £24 available to
those unable to attend the whole conference.

For further information see

www.itnetwork.org.uk/conf2k.htm
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2001 ICT in Practice Awards

Next January at the BETT show the first BECTa
TES awards sponsored by BT will be presented by
Lord David Puttnam. The awards, covering
England, Scotland. Wales and Northern Ireland, are
to promote and reward exemplary ICT practice
amongst teachers, lecturers, trainers and advisors. A
second aim is to discover practice that can be
widely emulated.

Each award winner will receive £2500, with an
additional £2500 going to their school or organisa-
tion. They will also agree to their work being
widely publicised. The practice can take the form
of doing traditional things in new and better ways
or of expanding the boundaries of what is possible.
The awards will reward practice that is replicable,
that will say to teachers, “you too can do this”.

These are the categories:

o [CTin Practice: School Management (Primary
and Secondary)

o [CT in Practice: Special Educational Needs
(Primary and Secondary)

e [CTin Practice: Subject Teaching (Primary and
Secondary)

» [CT in Practice: Advice and Support
e [CTin Practice in FE: Widening Participation
in Further Education

The judges will look for candidates who have:

commitment to the use of ICT for teaching and
learning;

» an understanding of how work has contributed to
raising standards;

e the ability to inspire and motivate students and
colleagues;

e visionary and sustainable ongoing plans.

Candidates for the awards have to nominated. The
process is explained on the BECTa site which is
open for nominations now. The closing date is 28
July 2000. Short-listing will take place immedi-
ately after that and short-listed candidates will be
visited by the judges during the autumn term.

www.becta.org.uk/practicewards
Any queries should be sent to:

practiceawards@becta.org.uk

Don’t get stuck on the grid!

Brian Richardson
CSH

Looking back to the early 1980s, being involved in
the production of educational software was both
exciting and innovative and, I have to say, it was
probably a bit hit and miss! No one really knew
what we should be doing with computers in our
schools, let alone what software we should be
producing, yet everybody seemed to have a model
theory of their own. Teachers who were lucky
enough to have computers in their classrooms
experimented with all kinds of software and
generally they were exciting times.

In 1984, we at Cambridgeshire Software House
published a program entitled Cars — Maths in
Motion and launched it at that year’s MAPE
Conference. Since starting our fledgling company
some 4 years earlier, we had produced about 20
programs and were becoming well known for our
simulations (Expedition to Sagqara, Adventure
Island, Mary Rose etc.). At the time, some teachers
were a little wary of using this type of software,
mostly through ‘fear of the unknown’, but ‘Cars’,

as it soon became known, was to change everything
for them. Here was a cross-curricular simulation.
based in the exciting world of Grand Prix racing.
that heavily featured practical mathematics and that
the children actually enjoyed using! Apart from
helping them to learn some basic skills. the
software showed children that mathematics could be
fun and 17 years later, the rest, as they say. is
history! The program became the most popular
cross-curricular simulation ever and many an in-
service training course from Winchester to Aberdeen
finished with teachers screaming at a 14 monitor in
the hope that it would make their car go faster!

The software has undergone little change since
its original publication and has, until now, only
been reprogrammed by us to cater for new operat-
ing systems. However, that has now all changed.
With ‘Maths Year 2000° in mind, we started over 2
years ago to completely redesign the program. We
wanted to put in some of your suggestions and
make the software even more relevant to the
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teaching methods of today. [ am very Maths in Motion
pleased to say that we showed the new
version at the recent NAACE Confer-
ence in Blackpool. I make no apology
for the fact that children will still need e
to use protractors, will still need to use ) var 1 Team Name
scale, will still need to calculate e U~ B
percentages and will still have the
opportunity to experiment with the
mathematical model. Children will be
able to ask ‘what happens if . . . 7,
‘what chance shall we take . .. ?" etc.
when using this software and they will
experience the use of ratios, measuring
angles, strategy, speed, time, bar, line
and conversion graphs whilst
attempting to set up a car to win a race.
As an aside, we have a very useful
support document on our web site

‘Maths in Motion'

(it l

(http://ourworld.compuserve.com/

homepages/cshsoft) which details the
T : parts of the Numeracy Document
Team 'CSH RACING' Planning §ﬁ§5 where the program covers various

{ Firing Useful Tnformation aspects of it for Years 5, 6, 7 and 8. We
' ; have also listed the parts of the
Scottish 5-14 Guidelines that are
covered by the program.

The launch went very well and one
of the new features that captured the
RS imagination of most delegates is the

Race planning ability to import and export cars from
and to other users of the software. This
will mean that schools could send cars
to each other and race against each
other.

The new program is called simply
 yet & } ‘Maths in Motion” and is available on

o ] CD-ROM. It is compatible with
Windows ’95 and *98 and costs £49.95

Temperament. - Enthusiastic i

Copyecar 1

Pit Team Briefing

Post-Race Analysis

the address below. | know from
correspondence that many teachers still
use what is now the old software to
help deliver the various curricula
requirements in their schools. I am
therefore pleased to tell you that if a
school returns to us the original
package, track plans and discs. then
that school can purchase the new
program for only £30.00 + carriage
and VAT. This offer will be open for a
very limited period only.

CSH can be contacted at:
Cambridgeshire Software House, P.O. : e - - ‘
Box 163, Huntingdon, Cambridgeshire tesrdes e ' - Gpeodlfestues?iz ]
PE28 3UR I ' e
Tel: 01487 741223; Fax: 01487 741213

* carriage and VAT, direct from us at
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In-Set with a difference!

Roger Keeling

Roger Keeling is head of Maths and IT at Newman College

r.keeling @newman.ac.uk

It seemed a good idea at the time —to go out to
Beirut for a short break in the autumn reading week
to see my daughter (Alison). We had been out there
12 months ago so we knew what to expect —a once
modern Middle Eastern city ravaged by years of
civil war but rapidly undergoing reconstruction.
This time, the journey out there was uneventful but
at the airport there was no one to meet us (Alison
has spent all her life being late — what’s new?). We
sat around waiting, exhibiting our typically English
trademark — three coats on in temperatures that
were in the mid 20s.

The following morning we were woken by the
kids playing at the school adjacent to Alison’s flat
(at 7.30!!) But there we were, November 1st, and the
kids, in short-sleeved shirts, were playing out in the
playground; basketball, volleyball and football all
happening simultaneously. This was a far cry from
the teachers back home whose hearts sink every time
someone declares yet again that it is a wet break.

However this trip had taken on a different
complexion. The Embassy where Alison works had
given some 486 PCs to some of the poorer schools
in Southern Lebanon and suggested that I might like
to go down there to show the teachers how best to
use them. In a moment of weakness I said ‘yes’ —it
was all due to be very low key. “By the way dad, it’s
in the war zone” — Israel has annexed a 15 mile strip
of Lebanese land to keep the Hezbollah guerrillas at
bay but they keep having a go at each other.

Each time I spoke to Alison the low-key event
took on a new twist:

“We’ll take you down in an APC — just in case”
(Armored Personnel Carrier — I didn’t know what it
stood for either), and then later:

“The two schools have now risen to six”, and
next time:

“The Ghanaian Commander of the UNIFIL
Force (United Nations Implementation Force in
Lebanon) will welcome you and take you to lunch”
(warning bells — I normally only have a banana
butty at lunchtime!) and so it went on . . .

“The six schools have now risen to twelve . . .”

“The press will be there.”

“The 12 schools have now risen to 20 .. .”

“The TV may be there.”

“It is taking place in the barracks but there is
only one demo computer.”

“Not all the teachers will speak English.”

“We will have to leave at 6 in the morning to get
there for an 8.30 start.”

Stop! Stop! This is all getting out of hand. Time
to press the panic button and abort the mission — but
that may have reflected badly on Alison. Trapped!! |
normally enjoy taking in-service sessions, but that is
when I know what to expect. This is different. The
language is different, the number system is different,
books start at the back page, and text reads from
right to left. What will they make of FD 60 RT 90
(Logo). Additionally, Alison and my wife will both
be in the audience — now I don’t mind lecturing to
students and teachers but kith and kin are a different
matter — rather worse than Ofsted. My only consola-
tion was that | was as well prepared as | have ever
been (but for those who know me that doesn’t say a
lot!). However thanks to Dr. Nakeeb I did have a
couple of handouts translated into Arabic.

We left Beirut at 6 in the morning and were
driven to the UNIFIL Compound in Tyre. The drive
was uneventful if you forgot to count the check-
points that we drove through. We were greeted by
the Ghanaian Colonel of the base and the Indian
Licutenant Colonel who is the UNIFIL Humanitar-
ian Officer. We also met two nuns (the first of the
teachers on the course). The nuns taught very close
to the Israeli border at En Naqoura in the occupied
zone and had to be brought to Tyre by UNIFIL —
the only way to guarantee their safety. but they
walked across the compound to greet us and
presented us with a warm breakfast (Lebanese
style) wrapped in tin foil. Throughout the day we
always found the same warm hospitality. The first
part of the schedule was a visit to the primary
school in Silaa. Problem — the Ghanaian Com-
mander of the main base wanted to meet us first
and this was a half-hour drive away. We drove up
into the hills to a small village called Kfar Dounine
which is where the base is positioned — a village of
porta cabins etc. that the Ghanaians have occupied
since 1978. In fact the UNIFIL force has comprised
battalions of Ghanaians, Fijians, Nepalese, Finnish,
Irish and Poles and has been there for nearly 22
years (so much for the concept of an interim force).
However if the Ghanaian Commander wished to
see us, who were we to argue — he has tanks!! We
were given a warm welcome, the usual drinks,
speeches, etc., before setting off again in convoy to
visit the primary school, to whom the Embassy
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were donating a brand new printer.
This was a village school of some
320 pupils set in the mountains.
The pupils were smartly dressed in
their uniforms and generally
overawed by the presence of two
British teachers, an Embassy
delegate, four journalists, and at
least 6 soldiers, two of whom were
filming the whole event. But even
here, in the mountains of Southern
Lebanon in occupied territory, these
children were learning English. In
this part of the world this was quite
unusual as children of this age
usually learn French as their second
language. Formalities completed,
and amidst smiles and waves from a
class of young children, we headed
back to the barracks. By this time
the rest of the teachers had arrived
and were seated and ready to go. The army had, in
fact, borrowed six computers from the desks of
soldiers to make it a hands-on session and had set up
a demo machine with an LCD panel on the OHP
projector — but by the looks of it the OHP had a 40
watt bulb in it rather than a 400 watt bulb!

First problem — my laptop would not interface
with their projector, or at least the top half of the
screen would but not the bottom half. This did not
look promising. However after some fiddling we
managed to get started. But first there were more
speeches. The Commander of the base was first,
Alison, on behalf of the Embassy, went next and the
UNIFIL Humanitarian Officer was next — the net
effect of all this was that a 2-hour session was
reduced to 1 hour.

I’ll not bore you with the details of the course
other than to say that we tried to cover some maths
software and some programs to support the teaching
of the English language. We did manage to run a
hands-on session. but when you ‘borrow’ six PCs
from the desks of officers. and then try to install
software on to the hard disks without understanding
the security that these officers have implemented to
protect their own systems, suffice it to say that it is
not without its frustrations. Lunch was in the
Officer’s Mess and was typical Ghanaian food
(what happened to vegetarianism?) — however, the
general hospitality was absolutely superb and
everyone was most kind and helpful.

But what did the teachers learn? The problem
with this type of initiative is that it requires two
things to happen. One is a support person in the
neighbourhood of the schools, particularly someone
who can solve the technical problems, and secondly
it requires the teachers themselves to form a self-
help network — not only to exchange the solutions to
technical problems but also to exchange ideas as to

S s 7 .
Posing in UN gear.

how they have used different programs. It is too
early to say whether this will happen, but we did
identify a couple of people who might be ‘movers’.

After taking a few photographs, posing in UN
gear, we were taken to a Palestinian Refuge Camp
and taken round by a British physiotherapist who
has been working out there for a couple of years.
This is the most depressing place that can be
imagined. These camps are not tented villages;
they are generally brick built but with little
sanitation and running water. They are virtually
self-supporting in that there are shops, schools etc.
but basically no opportunities. The residents are
strictly forbidden from improving their homes —
because they are only temporary residences (albeit
for the last 40+ years) and employment chances
are very low —and even when some do get employ-
ment, it is only in the most menial of jobs. Although
the question of the Palestinian Refuge Camps needs
to be addressed as part of the Middle East Solution,
expectations of a better future are next to nil — just
how do you cope with a homeless nation?

This is a country full of contrasts. Some
Lebanese are very well off, as is evidenced by the
cars they drive (although the way they drive them
is an entirely different story!) On the way to Tyre
we drove along © our’ side of the motorway, but as
the opposite direction was congested (northbound)
they simply swapped sides and started driving
north down the southbound lane! At the end of the
day we spent the evening in Tyre and dined in an
open-air café right by the side of the Mediterra-
nean. [t was a warm evening and we could sit,
drink wine and watch the fish. However we also
sat there listening to gunfire and spotting the
occasional flash in the distant hills. No one took
any notice — probably bored soldiers trying to
liven up their evening!
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Ten tips for using Word for your own productivity

1 | Use Tables + Tables are very valuable whenever you want to arrange things in rows and
columns or put things into boxes. This layout was originally created using the
Table function and any worksheet with questions and answers can be laid out
quickly and easily using Table.

« The best way to find out what is possible is to explore the Table menu on your
menu bar.

« You can change the width of columns by simply dragging the lines.

« Explore the Table Autoformat options (in the Table menu) to see loads of
different ways of presenting the work. The simplest layout is ‘Grid 1°.

2 | Use Bullets |+ The Format menu gives you many options for using Bullets and Numbering.

+ You can bullet ordinary text or you can use bullets and numbering within a
table as | have done here.

« This box is bulleted and the first column of this table uses numbered items. To
use different types of bullets for different columns in the table, first make sure
the cursor is in the column you want to set, and choose Select Column from
the Table menu. This will highlight the column. Now choose Bullets and
Numbering from the format menu and set the option you require.

« Numbers are adjusted automatically. This means that if | decide to add or delete
rows in my table the items in the first column will be renumbered accordingly.

3| Check your |+ Choose options from the Tools menu, click on the Spelling and Grammar tag

spelling and and tick the boxes to check spelling and grammar as you type.
grammar as |+ Whenever you make a spelling error the word will be underlined in red. Click
you type on the word with the right hand mouse button to see alternatives and select

the one you want.

« If you have spelt the word correctly you can add it to the dictionary with the
Add option.

« If the grammar you have used is deemed incorrect the text will be underlined
in green. This happens if you type monstrously long sentences for example.
Sometimes it can be irritating to be told the work is ungrammatical when it is
the way you want it! You may wish to turn this option off.

4 | Use « The AutoCorrect option in the Tools menu can be set to correct all your typos

Autocorrect automatically without even asking you. Moreover it can learn the mistakes you
make regularly and deal with these for you. | am a pretty mediocre typist and
often transpose letters — my machine puts them all right for me and | do not
even know | have made the error! This is very ego boosting.

- Explore the AutoCorrect option in the Tools menu and tick the options you
want to work with.

+ You will see a long list of the autocorrections which are already built in.

« When using the above option, which checks your spelling as you type, you
can add words to the AutoCorrect menu. Click on the word with the right hand
mouse button as before but now choose AutoCorrect. The options will be
presented again and as you choose the right one the autocorrection will be
automatically added to the list.

5 | Use text . Sometimes you want to create a worksheet or template with clearly defined

Frames areas for text to be entered. A good way to do this is to use text frames within
your document.

« The Drawing toolbar may already be showing — it is the bar which says Draw
at the left hand end. If it is not — select Toolbars from the View menu and
choose the Drawing toolbar.

« One of the items on this toolbar looks like a page of lines with a letter A in the
top left. Click on this and the cursor will change to a cross and allow you to
create a text frame in your document.

« This frame can be manipulated like a picture frame — repositioned, stretched, etc.

« Text inside the frame can be altered using the normal formatting tools.

« The template for an Annual Record of Achievement (available on the MAPE
website www.mape.org.uk) has been set up using text frames.
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Use Change
Case

You know how frustrating it is when you accidentally hit the caps lock key and
type three lines without noticing that it's all in capitals? Well this can be put
right simply using the Change Case option in the Format menu.

Explore the various options. Upper case can be changed to sentence case —
a capital will be used to start a sentence.

Add
illustrations

If you have a fairly up-to-date version of Word (eg Word97) you really do not
need a programme such as Publisher as you can easily mix text and graphics
on Word pages.

You can use clip art, as | have done here, or pictures created in other pack-
ages and stored as files.

From the Insert menu choose Picture and then whether you want to use
clipart or a file. Try things out with clipart to begin with.

Choose the image you want and click on Insert. The image will probably not
be exactly the right size or where you want it but this is easy to correct.

When the image appears in your document the Picture Toolbar may well
appear at the same time. If it does not choose Toolbars, then Picture from the
View menu.

The first thing to do is to make your picture float freely over the text so that
you can move it where you like without messing up the text. For this use the
wrap tool (a yellow diamond on a square ruled with lines). Click on the picture
to select it (you will see the little square handles all around it) and then on the
wrap tool and choose None. You can now move the picture around without
changing anything else.

Different kinds of wrap can be useful — you will need to experiment with them
to see what they do.

To resize the picture click on one of the handles and pull. A diagonal pull on
the bottom right handle will resize while keeping the original length/width
ratio.

It is worth exploring the rest of the Picture Tools — the clip tool (looks like two
Xs) is handy for shaving bits off.

Open
straight
into your
document

The quickest way to open a document which you have recently been working
on is to use the Windows Start button.

Choose Documents from the Start menu and you will see that the last 15
documents you have worked on are all listed. Click on the one you want and it
will open straight away.

(Not strictly a Word tip this as it is Windows which does this for you.)

Avoid
inappro-
priate line
breaks

Sometimes you put two words together (or more often perhaps a word and a
number) which are not hyphenated but which nonetheless need to stay
together to make sense — ‘Year 6, for example, or ‘Class 7’. A line break
between the word ‘Year’ and the number ‘6’ both looks odd and makes your
text hard to read.

To keep things together you need to use a ‘nonbreaking space’ instead of an
ordinary space between them.

To enter a nonbreaking space simply press Ctrl, Shift, Spacebar. What
appears looks just like a normal space but will not break over the end of a
line.

10

Buy yourself
a copy of
WORD for
DUMMIES

Do you know of the ‘for DUMMIES’ series of books on all sorts of computer
matters? They are comprehensive manuals written in a friendly and chatty
style which is both readable and accessible. Typical titles are ‘Internet for
Dummies’, ‘Windows98 for Dummies’ etc. There are loads of versions of
‘WORD for Dummies’ — get the one which matches your version of Word (eg
mine is WORD97).

The books can be found in computer shops like PC World or ordinary book-
shops. They are easily spotted as shelves of bright yellow tomes! They are
not cheap (my ‘WORD97 for Dummies’ cost £18.99) but they are well worth
the money.
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The Chris Robson Memorial Prize 1998

Nick Packard and Sally Smith judged this year’s competition

Picking the ‘best’ from everything published by
MAPE during 1998 was no mean feat! In total we
read over 50 articles, tackling a broad range of
issues (and an even broader range of interesting
and creative solutions) related to the use of ICT
with primary age children. Being judges gave us
the perfect excuse to really pore over all this work,
and we would like to thank everyone who submit-
ted articles to MAPE Publications last year.

In the end, we chose ‘Putting Hyperstudio to the
test’ by Steve Bailey as the winner of the Chris
Robson Memorial Prize for 1998. As the ICT
Coordinator of Paulton Junior School, Steve took
on an ambitious project — the development of a
‘Computer Prospectus’ for the school using the
multimedia program, Hyperstudio. This project
allowed members of the whole school to get
involved, it spanned age groups, types of software,
abilities and interests, and it had a real purpose and
a real audience to cater for.

If the time and effort involved in putting the
whole thing together wasn’t enough, Steve then
wrote an article describing the project, from
conception to presentation, for the MAPE Focus on
Art Pack, published during the Summer of 1998.
There were plenty of ‘gems’ in this piece, little
teaching points, organisational tips, potential
pitfalls and their solutions that might help other

MAPE readers to learn from his experiences.
Well done and thanks, Steve!

As last year’s winner of the prize I know the
encouragement it can give to a classroom
teacher and I offer my congratulations to
Steve. Reading his article I felt I could use his
ideas in my school. Reading a whole year’s
articles in a short period of time has given me
a wealth of ideas and renewed an enthusiasm
for ICT. Discovering what others have been
doing in their classrooms is a special encour-
agement. With the literacy and numeracy
strategies dominating our thoughts it is
especially interesting to have ideas from other
teachers to use in our classrooms, so whatever
ICT is happening in your room we would like
to hear (you never know; you might become a
prizewinner).

Sally Smith

The Chris Robson Memorial Prize (£200) is
awarded annually to the writer of the best article on
classroom practice from the previous year’s
publications. [t commemorates a former publica-
tions editor and MAPE stalwart, Chris Robson,
who died of breast cancer in 1995.

A day to remember

Rhona Dick
rhona @tagteacher.net

On 27th January Janice Staines, Sue O’Brien and I
took the train to London.

No we weren’t skiving, or off for a day’s
shopping, we were among the fortunate who’d
received an invitation from Valiant Technology to
the unveiling of their latest piece of educational
equipment, Math-U. Dressed in our finery we made
our way to the venue; no ordinary launch this, it
was to take place at the House of Lords.

The Houses of Parliament are not as old as
they’d have us believe. Largely rebuilt in the 19th
Century following a catastrophic fire, they are

presently undergoing something of a face-lift, and
some of the courtyards are shrouded in tarpaulins.
Despite this the delicacy of the carving on the
honey-coloured stone is breathtaking.

The Cholmondley Room is a long, narrow cham-
ber. Benefiting from almost no natural light the
dark green wallpaper lends an atmosphere of
gloomy solemnity a feeling reinforced by the oil
portraits of the great and the good that adorn the
walls.

We were welcomed by Kate Hudson and Gill
Manvell of Valiant Technology, and ushered
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through to the enclosed terrace overlooking the
River Thames.

The portcullis motif on the scarlet plush arm-
chairs was echoed on the etched glass doors to the
terrace. The weather was perfect, clear, bright and
very cold, making our view out over the river
almost dazzling. To the east we could see the
London Eye, then sadly still motionless, and to the

west the grey stone of Lambeth Palace.

Glasses of wine were replenished regularly and
the alcohol was soaked up by the most delicious
and delicate little canapés.

After being welcomed by Baroness Goudie,
Dave Catlin, Managing Director of Valiant Tech-
nology introduced Math-U to the assembled crowd.

In brief, Math-U is a Maths unit that acts as a
satellite to your computer. Up to a term’s work can
be downloaded and pupils can then use it at their
desks or even take it home. The design of the unit
is very child friendly — it has the appearance of a
games console.

Many consultants have been involved with
Math-U’s creation, and it is a testament to Valiant’s
commitment to quality that so many appropriate
specialists were appointed to collaborate on this
project.

Everyone was given the opportunity for some
hands-on as several Math-Us put in an appearance
around the room. The general consensus of opinion
was that Math-U has a lot going for him.

Eventually it was time to leave this unique venue,
but the three of us had had a day to remember.

A report, following a survey of IT in local
primary schools, by BEd Year | students in

November 1998

Cliff Warner

Lecturer in the School of Education at Derby University

Background

Computers were first introduced into primary
schools in this locality in 1981. These were BBC
model B machines and programs loaded by cassette
tape player. This was a tedious and often a frustrat-
ingly unsuccessful process. Within months schools
were provide with new “disc-drives’ with 5%
floppy discs. Loading programs became very easy
and the use of computers became commonplace
with most teachers, but using a very limited range
of mainly ‘drill and practise’ type programs. BBC
Master computers arrived during 1984 and this
meant an almost identical computer, but with a
larger RAM memory, now allowed a wider range of
enhanced software to be used in schools. Locally,
schools started to use Logo and the original
PenDown.

In 1988 schools began to purchase new Acorn

machines, firstly the Archimedes, later on A3000,
A4000/ 5000, until in 1994 RISC PCs and A7000s,
both with CD-ROM drives, became available and
the latter, at present, being the most popular
machine purchased throughout Britain for educa-
tional usage.

Unlike other curriculum areas, ICT is not just a
subject in its own right but also a tool used to
enhance and support the whole curriculum. In view
of the fact that ICT is a relatively recent addition to
the curriculum, there exists less expertise amongst
teachers than is the case for the longer established
subjects. This can also point to there being poten-
tially less confidence in the teaching and provision
of ICT in some schools.

There have been over the last 16 years in schools
‘waves’ of enthusiasm for ICT, often coinciding
with the launch of ‘new technology’. The introduc-
tion of the National Curriculum in 1988 raised
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awareness of the concepts of Information Technol-
ogy, but little more was being done in many
schools than had been achieved in 1985. Some
schools have doggedly kept up their ICT develop-
ment in line with the National Curriculum require-
ments, but, sadly, our students’ survey tends to
suggest that this is not widely evident. Perhaps we
already suspected this to be the case!

BEd Year 1 IT survey

In conducting this survey we are attempting to
ascertain to what extent the Statutory Orders for
Information Technology (DFE (1995)), are being
implemented in local schools. These indications,
evidenced in our survey, will be used to inform our
planning of future in-service courses offered to
local schools by the IT (Education) staff at the
University of Derby.

The survey was conducted by BEd Year 1
students on visiting their placement schools for
School Experience. The observations made by the
students formed part of an assignment in Educa-
tional Learning skills and Information Technology.
A total of 143 students visited the local schools and
they were given strict instructions to observe,
rather than interrogate, in order to compile the
information. No individual school has been
identified and no judgement or comment is
therefore made about any individual school.

« At Key stage 1:
‘Pupils should be taught to use
equipment and software confi-

to provide a wide range of in-service opportunities

for serving and newly qualified members of the

profession. We see these as ranging from quite
basic courses to the less popular areas of Control
and Modelling. These would complement any
training initiatives being used by Derbyshire and
our neighbouring LEAs.

Some evidence disclosed by the survey, we
understand, may be duplicated because all of the
schools remained anonymous and we are aware
that one or two schools will have more than one
student placed with them. This may give rise to
very small variations in the percentages quoted.

Some causes for concern in the use of IT which
have been highlighted by the survey:

« Much “drill and practise’ work is still being used
with programs such as Granny’s Garden,
Bottles, Mickey and other programs similar to
the original Anita Straker series circa 1984. This
was evidenced in 59% of the schools. These are
referred to as ULPs (useful little programs) in
the graph to show the use of specific programs.

» Wordprocessing programs, being the main usage
of IT in schools (75%), are being used to
produce ‘best copy’ of stories, topic reports etc.
first written by hand on paper instead of with an
original/creative writing tool, hence WP skills of
drafting and editing are not being taught.

« Despite a very high incidence of printers in
schools (98%), surprisingly a lower than
expected amount of display was seen to be
recorded; only 61% had any form of IT in their
school displays. Many schools had a few

dently and purposefully to
communicate and handle informa-
tion, and to support their problem
solving, recording and expressive
work.” — DFE (1995)

« At Key stage 2:
‘Pupils should be taught to

extend the range of IT tools that ehous 80 .
they use for communication,
investigate and control; become 60 -
discerning in their use of IT;
select information, sources and 40
143 schools '

media for their suitability for
purpose; and assess the value of
IT in their working practices.” —
DFE (1995).

In order to encourage a wider use of
relevant IT usage in our local
schools and so help our students to
develop even more ‘comfort’ in the
introduction of ALL the strands of
IT competence, we perceive a need

Graph to show the use of specific program
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printers available, either colour and/or black and
white, but few had one connected to every
computer. There appeared to be far fewer
printers in most schools than the total number of
computers. A few schools did not have the
correct ‘printer drivers’ to enable the printers to
be used and there was one school which had at
least one printer which they were unable to
configure or connect to the computer.
Framework programs such as My World are
being used in the ‘as is’ state rather than creating
screens to address specific teaching points and
children’s needs. 34% are recorded as using My
World at some time.

Few instances of modelling other than Logo and
adventure games were found, but of the 13%
which showed evidence of Logo-type programs,
half of these were in schools whose main type of
computer was RM Nimbus. This suggests that
only a small proportion (3%) of ‘Acorn-main’
schools actively use turtle graphics programs!
Only 35% of the schools had any evidence that
information handling packages were used at all
and these tended to be in the schools whose
main computer type was Acorn.

Alternative input devices e.g. CLICKER or
concept keyboards appear to be underused,
especially with special needs groups.

No evidence of sensors or control devices was
recorded.

Despite the range of CD-Roms available only
the encyclopaedia-specific ones seem to be used
regularly.

There was evidence of undirected use of a
computer at the end of sessions to ‘entertain’
children who had finished all their work!

e 10% of the schools had a designated and time-
tabled computer room/area; it may be therefore
assumed that the majority of schools use their IT
equipment within the classroom environment,
with small groups on perhaps one or two
computers.

In all the schools we surveyed the use of the Acorn
series of computers was by far the most prevalent.
The Derbyshire Authority and Derby City support
both Acorn and PC use, but it would seem that the
majority of educational software is available in the
Acorn format, some programs exclusively. Of the
schools which we found to be currently using
Acorns, 24% of these machines had CD-Rom
drives.

Following recent Ofsted inspections, several
local primary schools have acknowledged the
advice that their IT provision within the framework
of the National Curriculum is in need of some
additional attention. To an extent this view is
supported by the finding of our survey. It is clear
that to implement some of the features of the
Orders, Monitoring and Control, for example, extra
equipment may be needed and this of course has
ramifications for the overall budgetary considera-
tions within the provision of the Curriculum.

Update

During the past year, further information has been
sought with regard to the number of schools that
have a ‘connection’ to the Internet. This is a
constantly changing situation, almost on a weekly
basis, but during Autumn term 1999 our observed
schools showed that all the connec-
tions were completed. However, in

some cases the schools reported

Graph showing types of computers in having all the ‘equipment’ and

surveyed schools

connections but not, as yet, having
the ‘kit’ configured for Internet
usage. Of all the schools, 36% have
received training on their use of the

- Internet; 19% said they had begun to

use the web with the children. Of

the ones which are at the moment

connected 12% have been allocated

number of
schools 20+

. an email address and are using it to
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some extent.

’ Reference

DFE (1995) — Key Stages 1 and 2 of
the National Curriculum, HMSO,
London.
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Reviews

Ideas for integrating ICT into the primary and
secondary classrooms

Lewisham Education and Community Services

edited by Gill Deadman, 1999

Price: £4.00

This book of materials has been developed by

teachers in response to specific needs identified by

teachers themselves. The teachers wanted ideas for:

« integrating Literacy, Numeracy and ICT in the
primary classroom;

 developing the control strand of the 1T National
Curriculum which is currently poorly covered in
many primary schools;

« making effective use of Internet and email
throughout the curriculum to enhance teaching
and learning.

The book contains 24 distinct activities, each of

which is clearly and attractively presented in full

colour on a double page spread. The wide ranging
nature of these activities (they cover Reception up
to Year 9) means that the book is likely to be of
particular interest as a source book for ICT coordi-
nators who are developing schemes of work for
their schools. Subjects covered are the use of floor
turtles and screen logo, datalogging, databases,
multimedia authoring, email, creating web pages
and using the Internet for research. All the activi-
ties make use of generic software and should thus
be accessible by any school (two of them use

Microworlds Geoboards — Logo-based activities

which can be downloaded free of charge from the

LCSI website www.microworlds.com/library/math/

index.html).

Copious illustration makes the book very
‘browsable’ and the page layout makes it easy to

understand each activity at a glance with headings

- such as: Context (Pupils’ prior experience); Task

description; Learning intentions; Teaching ap-

proach; Links with other curriculum areas; and

Form of assessment.

Examples of pupils’ work and teacher evalua-
tions are shown and I particularly like the teachers’
assessment (with reasons) of the levels of attain-
ment shown by pupils in some of the activities.
This should be helpful for whole-school training
sessions on levelling.

At the back of the book are a number of pro
formas for activity planning, assessment and
evaluation. There are also some Computer diaries
for children to complete (a separate one for KS1, 2
and 3). All of these materials can be freely copied

for school use and are also available in electronic
form from the Lewisham ICT Centre website
www.lewisham-pdc.org.uk.

This is a useful and attractive resource book.
Congratulations to the team of classroom teachers,
ICT coordinators and advisory teachers who
produced it.

Heather Govier

BBC Maths Workshop — Number
Longman Logotron
CD-Rom for Windows and Macintosh
Minimum requirements:
Windows 95/98/NT 16 MB RAM
Power Macintosh 16MB RAM
Price: £49 (excluding VAT) for a single user licence

By and large I like this program, the first of three
tied in directly to the National Numeracy Strategy.
It provides 82 activities suitable for years 3—6 and
covering most of the objectives in the Number
Strand of the National Numeracy Strategy

The main menu is clear; there is no ambiguity
about the content of the different topics.

Teachers are able to create lists of pupils, and by
selecting the name of a pupil when running the
program a record of that child’s progress is kept.
These records can be printed out to provide
evidence of pupils’ achievements.

The activities menu is, if anything, even clearer
than the main menu (Fig. 1). A matrix sets out the
topics and activities by year. Key objectives are
highlighted; boxes beneath the objectives indicate
how many levels there are. As each level is
completed the appropriate box is coloured in,
giving an instant visual record. If you allow the
cursor to hover over the objectives, you are
provided with information about progression
through the levels. Another neat touch is the little
grey tab to the bottom right of the objectives;
pointing the mouse at this gives a thumbnail view
of the activity screen.

The activities (see menu, Fig. 2) themselves are
for the most part varied and interesting.

The screens are crisp and clear with no surplus
details to distract the pupils. Animation is kept to
the minimum which again I appreciate, reflecting
as it does the philosophy of maintaining pace
within a lesson. Sound is used sparingly — no
unnecessary bells and whistles.

Children can control their own progress, having
the option to repeat a level if desired, and teachers
may choose to allow pupils to make the decision
about progressing to the next level or not.

The Control Panel on the left serves two
functions. It contains the button allowing children
to repeat an activity, the Help button, and the
Ready button. It also provides a simple reward
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| Se!recfa‘ pupil

Properties of numbers and number sequences|

| Number sequences | Odd and even numbers

Multiples | Tests of divisibility

| Square numbers Prime numbers |

Place value, ordering and rounding |

| Avdding‘and subtraéting mntaHy Multiply or divide by 10, 100, 1000

Ordering whole numbers . | Ordering signed numbers ‘

Runding whole numbers

| Option to offer next activity is ON

Fig. 1. The main menu.

| [ Default Pupil [
Year5 | Year6

Recognise prime
numbers to at least |
20 :

Year 3
| Prime numbers

| Whole numbers in figures and words
| Read and write Read and write Read and write
| whole numbers o | whole numbers to | whole numbers in
1 atleast 1000in Jatleast 10 000 in | figures and words
figures and words 48 figures and words :
ool o e I I I I Joen
Place value (ThH T U)
Know what each Know what each
digit represents and | digit represents and
partition a 3-digit | partition a 4-digit
number (H T U} number (ThH TU) 4

Fig. 2. The activities menu.
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system for pupils by giving a
visual display of the progress
they have made. My one
criticism is that pressing the
Help button does nothing
more than allow pupils to hear
the instructions again rather
than clarifying the task, a
missed teaching opportunity
perhaps.

Success is rewarded with a
variety of encouraging
remarks; similarly mistakes
are treated in different ways.
In some activities children
lose points while in others
clues are provided.

My own favourite activities
are the ones involving
partitioning (Fig. 3). There is
only one example at each
level, which is perhaps a pity.
I’ve used this program with

50
60

40

- smaller - smallest

] ”“‘# i
EEi] |

wl

300 |
50

7

e

-

Fig. 3. Partitioning, Year 3.

two Year 5 children of different abilities; observing require pupils to give a number lying between two
the way they tackled this activity, in particular, was  other numbers. In both the integer and the decimal

enlightening! i , examples pupils just had to order a set of numbers.
~ Another activity I thought particularly good In fact the integer activity for giving a number
involved ordering fractions (Fig. 4). Pupils drag lying between two others was identical to the

and drop fractions to put them in order. When they  ordering activity. It may be that technology could
are happy with the order they click the Ready not cope with children typing in one of a range of
button and columns grow above the fractions numbers. If this is so then I would suggest that

giving a clear and accurate visual representation of  perhaps a computer is not suitable for practising

the relative sizes of the fractions.

this concept.

[ was disappointed with the activities that On balance, the minor

Fig. 4. Ordering fractions, Year 5.

quibbles I have are more than
outweighed by the clarity and
ease of use; I’'m sure this
program is one that will prove
of real benefit to teachers in
supporting pupils’ learning.

I look forward with interest
to seeing the next two
programs in this series.

Reader Offer

Logotron is offering a 20%
discount to MAPE members.
Mention this offer when you
order your copy of BBC
Maths Workshop — Number.

Rhona Dick
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A Multimedia Introduction to Sutton Park

Quercus Publications, 5 Hillcrest Road, Wylde
Green, Sutton Coldfield B72 1EG

Price: £20 CD-Rom only; £25 with educational
resource pack for schools

The aim of this pack is to provide teachers with
information that will enable them to get more out
of visits to the park. However if you don’t live
within travelling distance of Sutton Park, but have
a similar locallty near to you, then this multimedia
resource is valuable to you too. The pack includes a
comprehensive selection of
activities covering science,
literacy and ICT, as well as a
very informative and clearly
set out CD-Rom, touching on
other aspects of the park.

The CD-Rom

Installing this CD-Rom on
either Windows 3.1, 95, or 98
is easy; instructions are
printed on the CD-Rom itself,
and elsewhere. It is best
viewed with the video display
set to 640 x 480.

The opening three screens
give general information
about Sutton Park and its
location and there is the

Introductions, Animals and Plants, History, Views,
Visitor Centre and a very useful clickable Index. I
particularly liked part of the Introduction that gave
information about using the mouse, and watching
for the cursor to change to a hand.

T went straight to the History section. This had a
time line, spanning periods from 150,000 B¢ to the
present day, more or less. Annotations at the side
indicate some of the major events of the periods.
Clicking on a particular time span provides greater
detail. There are lots of interesting pieces of
information here, for example anyone who kept a

VIEWS OF SUTTON PARK

Click on a hotword to look at the phetograph.

>]

option to have this text read
out. This text is accompanied by maps that become
more detailed as we zoom in on the park itself. In
fact there are lots of useful maps throughout.

The contents are divided into clear sections,

h@aihéaﬁﬁ

dog here during the reign of King Athelstan (10th
Century) had to maim it in one leg so that it could
not chase the king’s beasts!

However the main thrust of this CD-Rom is
Science, so looking at the
Animals and Plants section
brings you to a sub-menu of the
different habitats to be found
within the park. A map (colour
coded to tie in with the habitats)
illustrates the locations of the
different habitats within the
park. Having selected one of the
habitats you are asked to choose
from animals, plants or fungi.

This is a very carefully
structured part of the CD, with
different classifications branch-
ing from each menu. At the
bottom of the screen there is a
back track bar enabling you to
trace your steps back one stage
at a time. In fact you are never
more than two clicks away from
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NOTES FOR TEACHERS 2:

SUMMARY OF Quercus ACTIVITY SHEETS

TITLE QF ACTIVITY SHEET  TYPE OF ACTIVITY | come [icomns] on e N | oiene "":“"Eﬁﬁ
MAMMALS THHHEAS RS
, Ky u 1-3: Sutton Park Mammals Chart completion from data on CD-ROM | / e ] e |/
A T I S British Mammals Chart completion from wider research VIV Y3 . yr| 3 [Jeehesten ] sesomn |/
2 QUIZ1: SUTTONPARKMAMMALS  Interpreting own entries on Chart 1 V] /]2 | 2a [ Saieme | matmn |/
3 QUIZ2A: BRITISH MAMMALS Interpreting own chart entries + research R T e I T BV
4 QUIZ2B: BRITISH MAMMALS Interpreting own chart eniries + research ViV Y3-Y7| 3+ | e | 2040min N4
S BRITISH MAMMALS FOOD CHART interpreting and re-presenting chart data i V| Y8 - Y7{ 3 | seaing tyves | s020mm |/
6 MAMMAL FOOD CHAIN PUZZLES Constructing food chains from chart data VIV [v3-v1] 3| preom | wsomn |/
INVERTEBRATES 3
1 KEY CHARACTERISTICS - INSECTS Chart completion from CD-ROM data | |/ V| vz-vr| 2 [ [ memn ]/
2 KEY CHARACTERISTICS- OTHER . Chart completion from CD-ROM data | / R A R s i | 1830 min Vi
3 QUIZ3: SUTTON PARK INSECTS Interpreting own entries on Chart 1 Vi v we.vr| 2 """":"‘; 160min | \/
4 QUIZ 4: ALL KINDS OF INVERTEBRATES Interpreting own chart entries + research | /[ [/ [ v3 - vz | 3¢ | Somiestn '} 0oy [ /
FOOD CHAIN PUZZLES
1 SUTTON PARK FOOD CHAINS Constructing food chains using CD-ROM | |/ VIvs-vi] 2| fwsee | somn |/
2 BRITISH ANIMALS FOOD CHAINS Constructing food chains from research VIV Jys-vi]se| Bvee | 2esomn
OBSERVATION AND IDENTIFICATION RECORDS:  BIRDS  FUNGI Vi vir-v] 3 et | 240w [/
"MINIBEAST HUNT" OBSERVATION RECORD  Sketch + Description V] ] v ve] 2a .
TREE SURVEY OBSERVATION RECORD + Tree Terminology Sheet Vi s Vi ] ] e e T
R A T NOTES FOR TEACHERS 2 ﬁ
e e » SUMMARY OF Quercus ACTIVITY SHEETS

the main menu, which is a real bonus.

A glossary provides information about some of
the more difficult or technical words in the text;
just click on any word in blue and you are taken to
the glossary. Much of the text is spoken, and
children can listen to the songs of the birds found
in the park as well.

The many illustrations, some drawings, some
photographs are first class. However I did find that
some of the pictures of flowering plants were too
small to pick out many details.

Supporting material

. Teachers’ notes provide all the information needed
to make use of this CD-Rom in your locality

whether or not you live within travelling distance
of Sutton Park.

There are 18 children’s activities covering such
topics as tree identification, a minibeast hunt (and
what a brilliant idea to include a ruler at the bottom
of the page!), food chains and quizzes. There are
completed characteristics record charts to help
teachers too!

There are so many resources here that teachers
may find it helpful to keep the activity sheets in
indexed plastic wallets.

This is a very slick package of resources.

No effort has been spared to provide information
to support teachers and children using this CD-
Rom.

Highly recommended!

Correspondence to the Editor: Rhona Dick, MAPE Publications, 121 Fitz Roy Avenue, Harborne,
Birmingham B17 8RG.
Published for MAPE by The Castlefield Press, Northamptonshire.
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